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Abstract: A Solar grass cutter is a machine that uses sliding blades to cut a lawn, that help human to cut 

grass automatically. Even more sophisticated devices are there in every field. Due to rapid development, 

many robots have turn into an autonomous robot. Power consumption becomes essential for future. The 

movement or the path of the Solar grass cutter is based on a path planning technique. Solar grass cutter is 

a very useful device which is very simple in construction. It is used to maintain and upkeep lawns in 

gardens, schools, college’s etc. 

In our project, we are using Arduino UNO, Bluetooth module, DC motor, solar panel. For this grass cutter, 

Arduino UNO microcontroller is utilized as the microcontroller. Sensors are used to provide feedback from 

outside world. We have made some changes in the existing machine to make its application easier at 

reduced cost. Our main aim in pollution control is attained through this. Unskilled operation can operate 

easily and maintain the lawn very fine and uniform surface look. Every action of the grass cutter is 

monitored by the ARDUINO UNO with the help of the sensors and Bluetooth module. In our 

project,―Solar grass cutter is used to cut the different grasses for the different application 

 

Keywords: Solar grass cutter 

 

I. INTRODUCTION 

Solar energy is a renewable source of energy. Its sources are divided into two types they are passive solar source and 

active solar source. These sources are completely depending upon how the solar energy is captured and it is distributed 

and also on how it is converted to the solar power. As we know the solar energy is free energy and it can be utilized 

easily. By using this solar energy, we operate solar grass cutter.  

In the market there are many different grass cutters are available such as gasoline-based grass cutter, electrical energy-

based grass cutter. The electrical grass cutter depends upon electricity and the gasoline-based grass cutter requires fuel 

to work. The burning of fuel in gasoline grass cutter cause air pollution as well as noise pollution. For the cutter 

machine large cable wire is required for cutting the grass of large area and the weight of motor is also heavy.  

So, as the technology is improving, we also need to replace the traditional conventional grass cutter to the new 

automated solar based grass cutter. So, from the above difficulties, tried to make an automated solar based grass cutter 

which having battery of 12V and a solar panel which used to store the solar energy in the battery. There are total 5 DC 

motors are used in the device from which 4 are used for moving device from one place to another and one big motor is 

used for cutting of the grass. These motors are connected to the motor driver and handled by Arduino UNO.  

Nowadays the automation plays very important role in the field of inventions and also automation is growing very 

rapidly. So, it plays very important role in the life of humans. Before, the grass cutter was handled manually that is by 

human contact and also, they require fuel or energy for working, Due to this there is lot of loss of fuel and energy and it 

causes pollution as fuel is used for running the device. 

 

II. REVIEW OF LITERATURE 

2.1 EXISTING SYSTEM 

Solar Based Grass Cutter : A Review " Ms. Bhagyashri R. Patil, Mr. Sagar S. Patil" , in the paper titled "Solar Based 

Grass Cutter : A Review " states that , conventional grass cutter consumes non-renewable sources of energy. So in order 

to be an alternate green grass cutter can be powered by using solar energy. 

B. Sensor Based Multipurpose Agricultural Cutter " Prof.J.P.Wagh, Aishwarya Chaudhari", in the paper titled " Sensor 

Based Multipurpose Agricultural Cutter " states that, the rotary mower can rotate about a vertical axis with the blade 

spinning at high speed and this tends to result in a rougher cut and shreds the grass leaf easily. 
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C. Solar based Grass Cutter with MPPT Tracking Panel " Ms. Gurav Sayali, Ms. Desai Pritam ", in the paper titled 

"Smart Solar based Grass Cutter with MPPT Tracking Panel " states that, adding an interfacing of

bank to charge the battery instantly can help the grass cutter run for long time.

G. Rahul portrays the use of solar energy to run the electric motor used for cutting grass. Bhosale and Khadake have 

presented the implementation of smart solar grass cutter. This system is driven by the solar energy by using solar panel 

and battery. This grass cutting machine was programmable for engine speed control.

To design a Smart Solar Grass Cutter, some parameters need to be considered such as the co

project, the position of the components, the structure of the main body, the advantages and disadvantages of the design 

and the safety factors. 

 

2.2 PROBLEM STATEMENT 

Solar energy is a renewable source of energy. Its sources

active solar source. These sources are completely depending upon how the solar energy is captured and it is distributed 

and also on how it is converted to the solar power. As we know the solar e

easily. By using this solar energy, we operate solar grass cutter.

 In the market there are many different grass cutters are available such as gasoline

based grass cutter. The electrical grass cutter depends upon electricity and the gasoline

to work. The burning of fuel in gasoline grass cutter cause air pollution as well as noise pollution. For the cutter 

machine large cable wire is required for cutting the grass of large area and the weight of motor is also heavy. So, as the 

technology is improving, we also need to replace the traditional conventional grass cutter to the new automated solar 

based grass cutter. 

 

III. METHODOLOGY

3.1 BLOCK DIAGRAM 

Coming to the working of solar powered grass cutter , it has panels mounted in a particular arrangement at an angle of 

45 degrees in such a way that it can receive solar radiation with high intensity easily from the sun

convert solar energy into electrical energy as studied earlier. Now this electrical energy is stored in batteries by using a 

solar charger. 

 

OPERATION MODULE 

The main function of the solar charger is to increase the current from the 

disconnects the solar panels from the batteries when they are fully charged and also connects to the panels when the 

charging in batteries is low. The motor is connected to the batteries through connecting wires

mechanical circuit breaker Bluetooth module is provided. It starts and stops the working of the motor. Bluetooth 

IJARSCT  ISSN (Online) 2581

   

International Journal of Advanced Research in Science, Communication and Technology

Access, Double-Blind, Peer-Reviewed, Refereed, Multidisciplinary Online Journal

Volume 4, Issue 6, May 2024 

DOI: 10.48175/IJARSCT-18513   

  

C. Solar based Grass Cutter with MPPT Tracking Panel " Ms. Gurav Sayali, Ms. Desai Pritam ", in the paper titled 

"Smart Solar based Grass Cutter with MPPT Tracking Panel " states that, adding an interfacing of

bank to charge the battery instantly can help the grass cutter run for long time. 

G. Rahul portrays the use of solar energy to run the electric motor used for cutting grass. Bhosale and Khadake have 

olar grass cutter. This system is driven by the solar energy by using solar panel 

and battery. This grass cutting machine was programmable for engine speed control. 

To design a Smart Solar Grass Cutter, some parameters need to be considered such as the components to be used in the 

project, the position of the components, the structure of the main body, the advantages and disadvantages of the design 

Solar energy is a renewable source of energy. Its sources are divided into two types they are passive solar source and 

active solar source. These sources are completely depending upon how the solar energy is captured and it is distributed 

and also on how it is converted to the solar power. As we know the solar energy is free energy and it can be utilized 

easily. By using this solar energy, we operate solar grass cutter. 

In the market there are many different grass cutters are available such as gasoline-based grass cutter, electrical energy

e electrical grass cutter depends upon electricity and the gasoline-based grass cutter requires fuel 

to work. The burning of fuel in gasoline grass cutter cause air pollution as well as noise pollution. For the cutter 

or cutting the grass of large area and the weight of motor is also heavy. So, as the 

technology is improving, we also need to replace the traditional conventional grass cutter to the new automated solar 

METHODOLOGY AND IMPLIMENTATION 

Coming to the working of solar powered grass cutter , it has panels mounted in a particular arrangement at an angle of 

45 degrees in such a way that it can receive solar radiation with high intensity easily from the sun

convert solar energy into electrical energy as studied earlier. Now this electrical energy is stored in batteries by using a 

The main function of the solar charger is to increase the current from the panels while batteries are charging, it also 

disconnects the solar panels from the batteries when they are fully charged and also connects to the panels when the 

charging in batteries is low. The motor is connected to the batteries through connecting wires .Between these two 

mechanical circuit breaker Bluetooth module is provided. It starts and stops the working of the motor. Bluetooth 
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to work. The burning of fuel in gasoline grass cutter cause air pollution as well as noise pollution. For the cutter 

or cutting the grass of large area and the weight of motor is also heavy. So, as the 

technology is improving, we also need to replace the traditional conventional grass cutter to the new automated solar 

Coming to the working of solar powered grass cutter , it has panels mounted in a particular arrangement at an angle of 

45 degrees in such a way that it can receive solar radiation with high intensity easily from the sun. These solar panels 

convert solar energy into electrical energy as studied earlier. Now this electrical energy is stored in batteries by using a 
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module is connected to android application device, though which we are moving this grass cutter inforward, backward, 

left, right direction. From this motor, the power transmits to the mechanism and this makes the blade to slide on the 

fixed blade and this makes to cut the grass. 

 
 

3.2 PROPOSED SYSTEM 

The grass cutter machines are becomes very popular today. Pollutions is manmade, which we can see in ours daily life. 

Old model of grass cutter IC engine are used and hence because of its environment impact pollutions level rise IC 

engine driven cutter is costlier. Maintenance of such conventional machines is very much. To avoid the drawbacks. The 

aim of our project grass cutter. The grass cutter has been obstacle sensor for obstacle detection. Grass cutter operate 

automatic hence it does not require skill person to operate. 

 

3.3 HARDWARE REQUIREMENTS 

 Arduino UNO 

 Bluetooth module 

 LCD Display 

 Motor driver IC 

 DC motor 30rpm 12v dc motor 

 Solar Panel 

 Battery 

 

3.4 SOFTWARE REQUIREMENTS 

 Arduino 

 Eagle 

 

3.5 HARDWARE DESCRIPTION 

ARDUINO 

Arduino is an open-source platform used for building electronics projects. Arduino consists of both a physical 

programmable circuit board (often referred to as a microcontroller) and a piece of software, or IDE (Integrated 

Development Environment) that runs on your computer, used to write and upload computer code to the physical board. 

Over the years Arduino has been the brain of thousands of projects, from everyday objects to complex scientific 

instruments. A worldwide community of makers - students, hobbyists, artists, programmers, and professionals - has 

gathered around this open-source platform, their contributions have added up to an incredible amount of accessible 

knowledge that can be of great help to novices and experts alike. 
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Steps to program an Arduino 

Programs written in Arduino are known as sketches. A basic sketch consists of 3 parts 

1. Declaration of Variables 

2. Initialization: It is written in the setup () function. 

3. Control code: It is written in the loop () function. 

The sketch is saved with.ino extension. Any operations like verifying, opening a sketch, saving a sketch can be done 

using the buttons on the toolbar or using the tool menu. 

The sketch should be stored in the sketchbook directory. 

Click on the upload button or chose upload from the tools menu. Thus the code is uploaded by the bootloader onto the 

microcontroller. 

 

Power (USB / Barrel Jack) 

Every Arduino board needs a way to be connected to a power source. The Arduino UNO can be powered from a USB 

cable coming from your computer or a wall power supply (like this) that is terminated in a barrel jack. In the picture 

above the USB connection is labeled (1) and the barrel jack is labeled (2). 

 

Reset Button 

Just like the original Nintendo, the Arduino has a reset button (10). Pushing it will temporarily connect the reset pin to 

ground and restart any code that is loaded on the Arduino. This can be very useful if your code doesn’t repeat, but you 

want to test it multiple times. Unlike the original Nintendo however, blowing on the Arduino doesn’t usually fix any 

problems. 

 

TX RX LEDs 

TX is short for transmit, RX is short for receive. These markings appear quite a bit in electronics to indicate the pins 

responsible for serial communication. In our case, there are two places on the Arduino UNO where TX and RX appear 

– once by digital pins 0 and 1, and a second time next to the TX and RX indicator LEDs (12).  

 

Main IC 

The black thing with all the metal legs is an IC, or Integrated Circuit (13). Think of it as the brains of our Arduino. The 

main IC on the Arduino is slightly different from board type to board type. If you want to know more about the 

difference between various IC’s, reading the datasheets is often a good idea. 

 

LCD (LIQUID CRYSTAL DISPLY) 

LCD (Liquid Crystal Display) screen is an electronic display module and find a wide range of applications. A 16x2 

LCD display is very basic module and is very commonly used in various devices and circuits. limitation of displaying 

special & even custom characters (unlike in seven segments), animations and so on. 
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 Pin No  Function  Name 

1 Ground (0V) Ground 

2 Supply voltage; 5V (4.7V – 5.3V)  Vcc 

3 Contrast adjustment; through a variable resistor  VEE 

4 Selects command register when low; and data register when high Register Select 

5 Low to write to the register; High to read from the register Read/write 

6 Sends data to data pins when a high to low pulse is given Enable 

7 

8-bit data pins 

DB0 

8 DB1 

9 DB2 

10 DB3 

11 DB4 

12 DB5 

13 DB6 

14 DB7 

15 Backlight VCC (5V) Led+ 

16 Backlight Ground (0V) Led- 

 

ALL LCD HAVE 

 Eight(8) Data pins 

 VCC (Apply 5v here) 

 GND (Ground this pin) 

 RS (Register select) 

 RW (read - write) 

 EN (Enable) 

 V0 (Set Lcd contrast) 

 

V0 (Set Lcd contrast) 

Set lcd contrast here. Best way is to use variable resistor such as potentiometer. Output of the potentiometer is 

connected to this pin. 

 

RS(Register select) 

Their are two registers in every lcd 

1 Command Register 

2 Data Register 

 

Command Register 

When we send commands to lcd these commands go to Command register and are processed their.Commands with 

their full description are given in the picture below. 

When RS=0    Command Register is Selected. 
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Data Register 

When we send Data to lcd it goes to data register and is processed their. 

When RS=1    Data Register is selected. 

 

RW(Read - Write) 

When RW=1  We want to read data from lcd. 

When RW=0  We want to write to lc 

 

Interfacing LCD 

 
VEE pin is meant for adjusting the contrast of the LCD display and the contrast can be adjusted by varying the voltage 

at this pin. This is done by connecting one end of a POT to the Vcc (5V), other end to  

16×2 LCD module commands 

16×2 LCD module has a set of preset command instructions. Each command will make the module to do a particular 

task. The commonly used commands and their function are given in  the  table below. 

Command                       Function 

0F LCD ON, Cursor ON, Cursor blinking ON 

01 Clear screen 

02 Return home 

04 Decrement cursor 

06 Increment cursor 

0E Display ON ,Cursor blinking OFF 

80 Force cursor to the beginning of  1st line 

C0 Force cursor to the beginning of 2nd line 

38 Use 2 lines and 5×7 matrix 

83 Cursor line 1 position 3 

3C Activate second line 

08 Display OFF, Cursor OFF 

C1 Jump to second line, position1 

OC Display ON, Cursor OFF 

C1 Jump to second line, position1 

C2 Jump to second line, position2 
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LCD initialization. 

The steps that has to be done for initializing the LCD display is given below and these steps are common for almost all 

applications. 

Send 38H to the 8 bit data line for initialization 

Send 0FH for making LCD ON, cursor ON and cursor blinking ON. 

Send 06H for incrementing cursor position. 

Send 01H for clearing the display and return the cursor. 

 

Sending data to the LCD. 

The steps for sending data to the LCD module is given below. I have already said that the LCD module has pins namely 

RS, R/W and E. It is the logic state of these pins that make the module to determine whether a given data input  is a 

command or data to be displayed. 

Make R/W low. 

Make RS=0 if data byte is a command and make RS=1 if the data byte is a data to be displayed. 

Place data byte on the data register. 

Pulse E from high to low. 

Repeat above steps for sending another data. 

 

BLUETOOTH 

As a world leader in short-range wireless connectivity, Laird offers the widest range of high-performance classic 

Bluetooth and Bluetooth Low Energy (BLE) modules for data and audio applications. With over a decade of experience 

in the development and production of Bluetooth wireless modules and associated development kits 

 
Setting up the HC-05 is as easy as ABC. All you need to know is the pin configuration. The HC-05 has 6 pins: wakeup, 

VCC, GND, TXD, RXD and State. Right now I will only deal with 3 pins, which are VCC, GND and TXD . 

Here is how you should connect the Bluetooth module to your Microcontroller. 

HC-06>>> Microcontroller 

VCC>>>>3.3v 

GND>>>>GND 

TXD>>>>RXD 

RXD>>>>TXD 
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The HC-05 acts as a serial port through which you can send and receive data. So using a serial terminal or a Bluetooth 

customized application on your computer or phone, you can control and monitor your project. I used Teraterm as the 

serial terminal. 

Before, uploading the code to the Microcontroller., disconnect the HC

interfere with the upload. Connect it back once the code has been uploaded successfully

This code allows you to switch on and off an LED using

See, we haven't written any code for Bluetooth communication. So, that's because Bluetooth communication is 

implicitly Serial Communication. And in Arduino, what you can do with the Serial 

declare the LED variable that accepts 12 (in other words the Digital PIN). And the char input that we will further use 

for accepting the user's instructions. 

 

MOTOR DRIVER IC  

L293D is a dual H-bridge motor driver integrated

low-current control signal and provide a higher

Pin diagram 
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05 acts as a serial port through which you can send and receive data. So using a serial terminal or a Bluetooth 

customized application on your computer or phone, you can control and monitor your project. I used Teraterm as the 

uploading the code to the Microcontroller., disconnect the HC-05 module, since it shares the tx/rx pins and will 

interfere with the upload. Connect it back once the code has been uploaded successfully 

This code allows you to switch on and off an LED using by sending a command to the Microcontroller.

 
See, we haven't written any code for Bluetooth communication. So, that's because Bluetooth communication is 

implicitly Serial Communication. And in Arduino, what you can do with the Serial Monitor in In the Definition part, we 

declare the LED variable that accepts 12 (in other words the Digital PIN). And the char input that we will further use 

integrated circuit (IC). Motor drivers act as current amplifiers

higher-current signal. This higher current signal is used to drive
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05 acts as a serial port through which you can send and receive data. So using a serial terminal or a Bluetooth 

customized application on your computer or phone, you can control and monitor your project. I used Teraterm as the 

05 module, since it shares the tx/rx pins and will 

Microcontroller.via Bluetooth. 

See, we haven't written any code for Bluetooth communication. So, that's because Bluetooth communication is 

Monitor in In the Definition part, we 

declare the LED variable that accepts 12 (in other words the Digital PIN). And the char input that we will further use 

amplifiers since they take a 

drive the motors. 
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Pin Description:  

 
 

DC MOTOR 

A DC motor in simple words is a device that converts direct current(electrical energy) into mechanical energy. It’s of 

vital importance for the industry today, and is equally important for engineers to look into the working principle of DC 

motor in details that has been discussed in this article. In order to understand the operating principle of dc motor we 

need to first look into its constructional feature. 

 

 
For the operation of dc motor, considering E = 0 

  
i.e. it’s the cross product of dq v and magnetic field B. 

  
Where dL is the length of the conductor carrying charge q. 

  
 

From the 1st diagram we can see that the construction of a DC motor is such that the direction of current through the 

armature conductor at all instance is perpendicular to the field.  

The torque produced is given by, 
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SOLAR PANEL  

Photovoltaic principles:  

The photo- voltaic effect can be observed in nature in a variety of materials that have shown that the best performance 

in sunlight is the semiconductors as stated above. A solar cell consists of  

 Semi –conductor in which electron hole pairs are created by the absorption of incident solar radiation. 

 Region containing a drift field for charge separation. 

 Charge collecting front and back electrodes.  

 

Photovoltaic effect 

The photo-voltaic effect can be described easily for p-n junction in a semi-conductor. In an intrinsic semi-conductor 

such as silicon, each one of the four valence electrons of the material atom is tied in a chemical bond, and there are no 

free electrons at absolute zero. If a piece of such a material is doped on one side by a five valance electron material, 

such as arsenic or phosphorus, there will be an excess of electrons in that side, becoming an n-type semi-conductor. 

 

SPECFICATIONS: 

Array size : 67×60cm 

Maximum Power : 50W  

Maximum Voltage : 12V 

 Maximum Current : 2.9A  

No of modules : 1 Type : Poly crystalline 

 

BATTERY 

The batteries are used as a storage device for solar energy which can be further converted into electrical energy. To be 

economically attractive the storage of solar electricity requires a battery with following particular combination of 

properties:  

(1) Low cost  

(2) Long life  

(3) High reliability  

(4) High overall efficiency  

 

VOLTAGE REGULATORS 

The most commonly used regulating modes will be covered. The linear regulator is the basic building block of nearly 

every power supply used in electronics. The IC linear regulator is so easy to use that it is virtually foolproof, and so 

inexpensive that it is usually one of the cheapest components in an electronic assembly.  

 

VOLTAGE REGULATOR IC 7805: 

7805 is a voltage regulator integrated circuit. It is a member of 78xx series of fixed linear voltage regulator ICs. The 

voltage source in a circuit may have fluctuations and would not give the fixed voltageoutput. 
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PUSH BUTTONS 

 
A push-button (also spelled pushbutton) or simply button is a simple switch mechanism for controlling some aspect of a 

machine or a process. Buttons are typically made out of hard material, usually plastic or metal. The surface is usually 

flat or shaped to accommodate the human finger or hand, so as to be easily depressed or pushed. Buttons are most often 

biased switches, though even many un-biased buttons (due to their physical nature) require a spring to return to their 

un-pushed state 

 

Uses: 

In industrial and commercial applications push buttons can be linked together by a mechanical linkage so that the act of 

pushing one button causes the other button to be released. In this way, a stop button can "force" a start button to be 

released. This method of linkage is used in simple manual operations in which the machine or process have no electrical 

circuits for control. 

Pushbuttons are often color-coded to associate them with their function so that the operator will not push the wrong 

button in error. Commonly used colors are red for stopping the machine or process and green for starting the machine 

or process. 

 

Push to ON button: 

 
Fig 4.7(a): push on button 

Initially the two contacts of the button are open. When the button is pressed they become connected. This makes the 

switching operation using the push button. 

 

1N4007 

Diodes are used to convert AC into DC these are used as half wave rectifier or full wave rectifier. Three points must he 

kept in mind while using any type of diode.  

Maximum forward current capacity  

Maximum reverse voltage capacity  

Maximum forward voltage capacity  



IJARSCT  ISSN (Online) 2581-9429 

    

 

       International Journal of Advanced Research in Science, Communication and Technology (IJARSCT) 

                               International Open-Access, Double-Blind, Peer-Reviewed, Refereed, Multidisciplinary Online Journal 

Volume 4, Issue 6, May 2024 

Copyright to IJARSCT DOI: 10.48175/IJARSCT-18513   72 

www.ijarsct.co.in  

Impact Factor: 7.53 

 

 
The number and voltage capacity of some of the important diodes available in the market are as follows:  

Diodes of number IN4001, IN4002, IN4003, IN4004, IN4005, IN4006 and IN4007 have maximum reverse bias voltage 

capacity of 50V and maximum forward current capacity of 1 Amp.  

Diode of same capacities can be used in place of one another. Besides this diode of more capacity can be used in place 

of diode of low capacity but diode of low capacity cannot be used in place of diode of high capacity. For example, in 

place of IN4002; IN4001 or IN4007 can be used but IN4001 or IN4002 cannot be used in place of IN4007.  

 

PN JUNCTION OPERATION 

Now that you are familiar with P- and N-type materials, how these materials are joined together toform a diode, and the 

function of the diode, let us continue our discussion with the operation of the PNjunction. But before we can understand 

how the PN junction works, we must first consider current flow inthe materials that make up the junction and what 

happens initially within the junction when these twomaterials are joined together. 

 

Current Flow in the N-Type Material 

Conduction in the N-type semiconductor, or crystal, is similar to conduction in a copper wire. Thatis, with voltage 

applied across the material, electrons will move through the crystal just as current wouldflow in a copper wire. As an 

electron leaves the crystal, an electron from the negative terminal of the battery willenter the crystal, thus completing 

the current path. Therefore, the majority current carriers in the N-typematerial (electrons) are repelled by the negative 

side of the battery and move through the crystal towardthe positive side of the battery. 

 

RESISTORS 

A resistor is a two-terminal electronic component designed to oppose an electric current by producing a voltage drop 

between its terminals in proportion to the current, that is, in accordance with Ohm's law: 

 V = IR 
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A resistor is a two-terminal passive electronic component

The reciprocal of the constant of proportionality is known as the 

value of R further "resists" the flow of current I as given by 

  
 

Units 

The ohm (symbol: Ω) is the SI unit of electrical resistance

volt per ampere. Since resistors are specified and manufactured over a very large range of values, th

milliohm (1 mΩ = 10−3 Ω), kilohm (1 kΩ = 10

 

Adjustable resistors 

A resistor may have one or more fixed tapping points so that the resistance can be changed by moving the 

wires to different terminals. Some wire wound power resistors have a tapping point that can slide along the resistance 

element, allowing a larger or smaller part of the resistance to be used.

 

Potentiometers 

A common element in electronic devices 

controlled by rotation of a shaft or knob. These variable resistors are known as 

are present, since they act as a continuously adjustable 

radio receiver.  

 

CAPACITORS 

A capacitor or condenser is a passive electronic component consisting of a pair of conductors separated by a dielectric. 

This field stores energy and produces a mechanical force between the plates. The effect is greatest between wide, flat, 

parallel, narrowly separated conductors. 

Capacitors are widely used in electronic circuits for blocking 

filter networks, for smoothing the output of 

frequencies and for many other purposes. 

 

Theory of operation 

Capacitance 

Charge separation in a parallel-plate capacitor causes an 

and increases the capacitance. 
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electronic component which implements electrical resistance as a circuit element. 

e constant of proportionality is known as the resistance R, since, with a given voltage V, a larger 

value of R further "resists" the flow of current I as given by Ohm's law: 

electrical resistance, named after Georg Simon Ohm. An ohm is equivalent to a 

. Since resistors are specified and manufactured over a very large range of values, th

Ω), kilohm (1 kΩ = 103 Ω), and megohm (1 MΩ = 106 Ω) are also in common usage.

A resistor may have one or more fixed tapping points so that the resistance can be changed by moving the 

wound power resistors have a tapping point that can slide along the resistance 

element, allowing a larger or smaller part of the resistance to be used. 

A common element in electronic devices is a three-terminal resistor with a continuously adjustable tapping point 

controlled by rotation of a shaft or knob. These variable resistors are known as potentiometers when all t

are present, since they act as a continuously adjustable voltage divider. A common example is a volume control for a 

is a passive electronic component consisting of a pair of conductors separated by a dielectric. 

This field stores energy and produces a mechanical force between the plates. The effect is greatest between wide, flat, 

Capacitors are widely used in electronic circuits for blocking direct current while allowing alternating current

etworks, for smoothing the output of power supplies, in the resonant circuits that tune radios to particular 

 
plate capacitor causes an internal electric field. A dielectric (orange) reduces the field 
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as a circuit element. 

R, since, with a given voltage V, a larger 

. An ohm is equivalent to a 

. Since resistors are specified and manufactured over a very large range of values, the derived units of 

Ω) are also in common usage. 

A resistor may have one or more fixed tapping points so that the resistance can be changed by moving the connecting 

wound power resistors have a tapping point that can slide along the resistance 

terminal resistor with a continuously adjustable tapping point 

when all three terminals 

. A common example is a volume control for a 

is a passive electronic component consisting of a pair of conductors separated by a dielectric. 

This field stores energy and produces a mechanical force between the plates. The effect is greatest between wide, flat, 

alternating current to pass, in 

that tune radios to particular 

internal electric field. A dielectric (orange) reduces the field 
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A simple demonstration of a parallel-plate capacitor

Examples of dielectric mediums are glass, air, paper, 

identical to the conductors.  

The capacitor is a reasonably general model for electric fields within electric circuits. An ideal capacitor is wholly 

characterized by a constant capacitance C

between them:  

  
Sometimes charge build-up affects the capacitor mechanically, causing its capacitance to vary. In this case, capacitance 

is defined in terms of incremental changes:

  
 

Energy storage 

Work must be done by an external influence to "move" charge between the conductors in a capacitor. When the 

external influence is removed the charge separation persists in the electric field and energy is stored to be released when 

the charge is allowed to return to its equilibrium

 

Current-voltage relation 

The current i(t) through any component in an electric circuit is defined as the rate of flow of a charge 

through it, but actual charges, electrons, cannot pass through the dielectric layer of a capacitor, rather an electron 

accumulates on the negative plate for each one that leaves the positive plate, resulting in an electron depletion and 

consequent positive charge on one electrode that is equal and opposite to the accumulated negative charge on the other. 

Thus the charge on the electrodes is equal to the 

discussed above. As with any anti derivative

This is the integral form of the capacitor equation, 

 

LED 

LEDs are semiconductor devices. Like transistors, and other diodes, LEDs are made out of silicon. What makes an LED 

give off light are the small amounts of chemical impurities that are added to the silicon, such as gallium, arsenide, 

indium, and nitride.         

When current passes through the LED, it emits photons as a byproduct. Normal light bulbs produce light by heating a 

metal filament until it is white hot.  LEDs produce photons directly and not via heat, they are far more efficient than 

incandescent bulbs.   

Fig 4.12(a): Typical LED
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plate capacitor 

Examples of dielectric mediums are glass, air, paper, vacuum, and even a semiconductor depletion region

The capacitor is a reasonably general model for electric fields within electric circuits. An ideal capacitor is wholly 

C, defined as the ratio of charge ±Q on each conductor to the voltage 

up affects the capacitor mechanically, causing its capacitance to vary. In this case, capacitance 

is defined in terms of incremental changes: 

must be done by an external influence to "move" charge between the conductors in a capacitor. When the 

external influence is removed the charge separation persists in the electric field and energy is stored to be released when 

equilibrium position. 

) through any component in an electric circuit is defined as the rate of flow of a charge 

through it, but actual charges, electrons, cannot pass through the dielectric layer of a capacitor, rather an electron 

accumulates on the negative plate for each one that leaves the positive plate, resulting in an electron depletion and 

t positive charge on one electrode that is equal and opposite to the accumulated negative charge on the other. 

Thus the charge on the electrodes is equal to the integral of the current as well as proportional to the voltage as 

derivative, a constant of integration is added to represent the initial vol

This is the integral form of the capacitor equation,  

LEDs are semiconductor devices. Like transistors, and other diodes, LEDs are made out of silicon. What makes an LED 

give off light are the small amounts of chemical impurities that are added to the silicon, such as gallium, arsenide, 

When current passes through the LED, it emits photons as a byproduct. Normal light bulbs produce light by heating a 

metal filament until it is white hot.  LEDs produce photons directly and not via heat, they are far more efficient than 

   
Fig 4.12(a): Typical LED       Fig 4.12(b): circuit  symbol 
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depletion region chemically 

The capacitor is a reasonably general model for electric fields within electric circuits. An ideal capacitor is wholly 

on each conductor to the voltage V 

up affects the capacitor mechanically, causing its capacitance to vary. In this case, capacitance 

must be done by an external influence to "move" charge between the conductors in a capacitor. When the 

external influence is removed the charge separation persists in the electric field and energy is stored to be released when 

) through any component in an electric circuit is defined as the rate of flow of a charge q(t) passing 

through it, but actual charges, electrons, cannot pass through the dielectric layer of a capacitor, rather an electron 

accumulates on the negative plate for each one that leaves the positive plate, resulting in an electron depletion and 

t positive charge on one electrode that is equal and opposite to the accumulated negative charge on the other. 

onal to the voltage as 

is added to represent the initial voltage v (t0). 

LEDs are semiconductor devices. Like transistors, and other diodes, LEDs are made out of silicon. What makes an LED 

give off light are the small amounts of chemical impurities that are added to the silicon, such as gallium, arsenide, 

When current passes through the LED, it emits photons as a byproduct. Normal light bulbs produce light by heating a 

metal filament until it is white hot.  LEDs produce photons directly and not via heat, they are far more efficient than 
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Types of LED’S 

LEDs are produced in an array of shapes and sizes. The 5 mm cylindrical package is the most common, estimated at 

80% of world production. The color of the plastic lens is often the same as the actual color of light emitted, but not 

always. For instance, purple plastic is often used for infrared LEDs, and most blue devices have clear housings. There 

are also LEDs in extremely tiny packages, such as those found on blinkers and on cell phone keypads. The main types 

of LEDs are miniature, high power devices and custom designs such as alphanumeric or multi-color. 

 
Fig 4.12(c) Different types of LED’S 

Colors and materials of LED’S 

Conventional LED’S are made from a variety of inorganic semiconductor materials, the following table shows the 

available colours with wavelength range, voltage drop and material. 

 

White LED’S 

Light Emitting Diodes (LED) have recently become available that are white and bright, so bright that they seriously 

compete with incandescent lamps in lighting applications. They are still pretty expensive as compared to a GOW lamp 

but draw much less current and project a fairly well focused beam. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

3.6  SOFTWARE DESIGN 

ARDUINO ID 
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Arduino IDE is an open-source software, designed by Arduino.cc and mainly used for writing, compiling & uploading 

code to almost all Arduino Modules. 

It is an official Arduino software, making code compilation too easy that even a common person with no prior technical 

knowledge can get their feet wet with the learning process. 

It is available for all operating systems i.e. MAC, Windows, Linux and runs on the Java Platform that comes with 

inbuilt functions and commands that play a vital role in debugging, editing and compiling the code. 

A range of Arduino modules available including Arduino Uno, Arduino Mega, Arduino Leonardo, Arduino Micro and 

many more. 

Each of them contains a microcontroller on the board that is actually programmed and accepts the information in the 

form of code. 

The main code, also known as a sketch, created on the IDE platform will ultimately generate a Hex File which is then 

transferred and uploaded in the controller on the board. 

The IDE environment mainly contains two basic parts: Editor and Compiler where former is used for writing the 

required code and later is used for compiling and uploading the code into the given Arduino Module. 

 

EAGLE 

INTRODUCTION 

This tutorial leads you through the steps necessary to make a simple two-sided PCB using EAGLE. This guide is 

operational: it shows in detail what you do and how to do it. Before you start the tutorial take 5 minutes to go through 

the Cadsoft EAGLE Guided tour, to get an overview. It will pay you to work through all of this guide, following the 

steps yourself, before attempting your first unguided PCB. A short note about the EAGLE on-line help documentation. 

This is pretty good but based on the command-line interface to EAGLE. 

Inorder to design a PCB, you need to complete the following steps: 

1. Create a schematic sheet & add components 

2. Add nets to the schematic (connect components) 

3. Check schematic (Electrical Rule Check or ERC) 

4. Create a board outline 

5. Position components on the board 

6. Route tracks between the components 

7. Check board (Design Rule Check or DRC) 

8. Pour copper to fill empty spaces on the board 

9. (optional) Add text legends to PCB layout 

10. Perform Final Checks 

 

BEFORE STARTING 

Before Starting You will want (or if using EAGLE on a networked workstation need) to change the default project 

directory. Start the EAGLE control panel. Options->Directories gives a list of directories. Change the projects directory 

if necessary to something convenient that you can write, e.g. on the EEE system H:/EAGLEProjects. All new projects 

will be created inside this directory, and the EAGLE project navigator in the control panel uses this as a root. For more 

advanced use you may wish to change the other directories also. The directory changes made are saved under "My 

Documents" as eaglerc.usr, so normally need to be made only once.  

 

Step 1: Schematic Creation  

Make a project for your PCB design 

Start the EAGLE Control Panel application. 

Create a new project: 

File->New->Project. 

Rename the project if you wish as follows: the control panel window indicates whether a project is open with a green 

circle next to the project name. Click this if necessary to close the project. Then 
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Right-click-> 

Rename on the project's name 

After having renamed the project you can reopen it. 

Right-click on the Project name ->New->Schematic. The schematic window will open. Inside the schematic window: 

File->Save as (choose a suitable name for your schematic sheet. NB - the freeware version of EAGLE allows only one 

sheet per design). For the first half of this tutorial you will be working with the schematic window, and can minimise 

the control panel window 

Open component libraries 

By default all the standard EAGLE libraries are open which makes it inconvenient to select your components from the 

EEE library. Download the design project library from the web and save it somewhere, for example (on the 

departmental system) to: 

 h:\eagle\lbr\ee2parts.lbr 

In the schematic command window (long thin box at top) type the following commands to change the open libraries: 

USE -* USE h:\eagle\lbr\ee2parts.lbr 

or  

USE < this displays an open file dialog box to find and open your library> 

 If you want to use components from the standard libraries they can all be reopened again with "USE *". However the 

ee2parts components have hole sizes suitable for easy hand soldering and should be used preferentially - they contain 

all the components needed for the design project. 

 

Add components to your schematic 

 Edit->Add-> Select component 

Each open library in the ADD window contains a list of components (click + if not visible). Some components have 

multiple packages (click on + to select the correct package). The component schematic symbol and package layout 

appear in the two windows to the right of the library window. Each component has a description you can check to see 

what it is. When you have identified the correct component and package (component & package will be visible in the 

two windows) click OK to start the ADD procedure (NB DONT click Drop in this box, if you do this you will lose the 

current component and need to re-open the library with USE to retrieve it). The ADD window will vanish and a 

schematic outline will track the cursor when it is over the main schematic sheet window.  

 Any number of components can be added to your schematic in any order. As described above you can position and 

even rotate components as they are added to the schematic. However components can also be moved after adding, with 

the Edit->Move command, or rotated with the Edit->Rotate command. Note that these menu commands can also be 

selected using the buttons on the left side of the schematic sheet window. (See also Edit->Smash in Step 3a).  

 
Add nets to schematic 

Use the Draw->Net command to connect components. DO NOT use Draw->Wire. 

Draw->Net 
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Left-mouse click on end of source pin or wire, left-mouse click when a change of direction in the wire is required, left-

mouse click on the destination.  

EAGLE has an excellent unlimited UNDO facility (Edit->Undo). Use this when nets go wrong. If they go very wrong 

use Edit->Delete (followed by right-clicks on unwanted objects) to remove unwanted nets and start again. 

Step 2a Add supply connectors to the schematic  

Supply connectors are a special type of component which does not exist physically on the PCB. Some ICs have supply 

pins which do not show on the schematic symbol. These will be automatically connected to a net with the correct 

supply connector (which has the same name as the pin).  

Step 2b add I/O pads and test points to the layout 

To get signals on and off the PCB you need either connector components or connecting wires. The best way to join 

wires to a prototype PCB is via terminal pads which have circuit pins soldered - wires can then be soldered to the pins. 

Add the PAD-TERMINAL component from the EEE library to allow wires for the V+, V- and GND supplies.Add test 

points (PADTESTPOINT component) to these nets.  

 
 

PROTEUS 

The difficulties of traditional electronics teaching and experiment lie in the difficult understanding of the  teaching  

contents;  the  lack  of  effective  links  between  courses;  the  lack  of  usage  rate  of experimental equipment; the lack 

of traditional experimental experiment content and programming; the lack of a good platform for MCU software 

teaching; the lack of comprehensive experiments and innovative experimental means [1]. It is difficult to train large 

numbers of qualified applied talents. 

 

INTRODUCTION 

The difficulties of traditional electronics teaching and experiment lie in the difficult understanding of the teaching 

contents; the lack of effective links between courses; the lack of usage rate of experimental equipment; the lack of 

traditional experimental experiment content and programming; the lack of a good platform for MCU software teaching; 

the lack of comprehensive experiments and innovative experimental means [1]. It is difficult to train large numbers of 

qualified applied talents. 

 

METHOD 

Proteus is a complete development platform from product concept to design completion. Its advantages are intelligent 

principle layout, hybrid circuit simulation and accurate analysis, single-chip software debugging, single-chip and 

peripheral circuit co-simulation, PCB automatic layout and wiring. Labcenter, a British company and Proteus software 

developer, has been developed around the world for nearly 20 years. It is currently the most powerful and cost-effective 

EDA tool in more than 50 countries.  
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Development process  

The traditional product development process is as following figure 2: firstly, the circuit diagram is designed, the layout 

of the circuit board is designed, and after a certain time there is a prototype, then the code is designed, the model is 

obtained by testing the layout of the board, the error of the prototype, the optimization of the code design and so that the 

model will be modified, so there will be some changes. The questions are as follows: 1. There’s no physical prototype 

which could test the system.  

 
 

BLUETOOTH CONTROLLER 

INTRODUCTION 

Already thriving within the telecommunications market, wireless technology is preparing to embrace computing on an 

even larger scale. Presently, most people encounter wireless local area networks (WLANs) in airport lounges and tech-

savvy officesFor this user has to first find a computer then wait for it to boot up, then plug in his device, and then 

transfer the data. 

Different types of USB ash devices are used now-a-days. It is not necessary that all of these devices are supported by 

the computer and the operating system and their device drivers are available and installed. Carrying a computer or a 

laptop just for the sake of data transfer is not affordable these days in the age when people want 
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IV. RESULTS AND DISCUSSIONS 

4.1 RESULTS 

Our output which looks similar that we have worked on solar grass cutter as shown 

 
 

4.2 ADVANTAGES 

 Compact size and portable  

 Easy to move from one place to another place  

 Operating principle is simple.  

 Non-skilled person also operate this machine  

 

4.3 DISDAVANTAGES 

 Large time required to remove the grass  

 Manually operated  

 Difficult to operate in rainy seasons  

 

4.4APPLICATION  

 For cricket ground.  

 The football ground.  

 All garden  

 All Playground  

 

V. CONCLUSION 

The design of fully automated solar grass cutter was tested successfully under manual and automatic operational modes. 

Compared to manual mode, the autonomous operation of the lawn mower resulted in a more efficient way of cutting the 

lawn, greatly reducing the cutting time by about 57%. By our design determinately we conclude that the fully 

automated solar grass cutter robot with impediment avoidance plays very key role in these days because to reduce 

pollution due to gas and petrol engines, it reduces the jeopardy for the users. 

 

5.1 FUTURE SCOPE 

 Design of blades should be done based on types of grass is used to cut.  

 Add camera for give a simple way to see the location of the lawn mower.  

 Attach wi-fi and Xbee module for longer distance of wireless control for the Lawn Mower.  

 Size can be reduced to make it compact.  

 We can use this product as floor cleaner simply changing blades by floor cleaner mop. 

 Design this product on the IoT (Internet of Things). 
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